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Notice 

The content in this document represents the current view of Empress Media Asset Management, 
LLC as of the date of publication. As Empress responds continually to the changing market 
conditions, this document should not be interpreted as a commitment on the part of Empress.  
Empress cannot guarantee the accuracy of any information presented after the date of 
publication. 

Empress is a US registered trademark of Empress Media Inc., and is used by permission. eMAM 
logos are US registered trademarks of Empress Media Asset Management, LLC. 

Information in this document is subject to change without notice.  
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Introduction  

eMAM is a powerful and flexible media asset management which allows you to easily work with content 

from any global location on any web browser or through native iPAD and android applications. eMAM 

can integrate multiple workflows for a variety of different organizations. Adobe Premiere Pro is a 

powerful editing tool offering a rich feature set integrated with entire Adobe product line for the 

entire range of video, audio and images requirements.  

Together eMAM and Adobe Premiere Pro offer a seamless integration. Editors can access the MAM 

system using an extension panel within Adobe Premiere Pro so they can access all of the content 

without leaving the editing desktop. eMAM tools can be used from a tablet or any web enabled device, 

anywhere, anytime, to review, annotate, mark, perform rough cuts, create projects and assign 

projects to editors.  The combined strengths of the eMAM and Adobe Premiere Pro systems can power 

multiple workflows. 

 

        
 

With the built-in panel, eMAM can now make editing an open process through its powerful media asset 

management tools. In a shared editing environment, multiple editors can work on the same Premiere 

Pro project from a shared centralized storage environment. eMAM manages content in such an 

environment and can now open up the editing and media management workflows for worldwide 

collaboration and flexible storage possibilities. The extension panel can now easily export projects 

from an editor’s desktop to eMAM, or input projects, categories (folders), or individual assets.  Beyond 

projects, eMAM can also manage project versions, bins, assets, and categories.  

http://www.empressmam.com/
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Getting started  

System Pre requisites: Adobe recommends standard hardware and software requirements 

for Adobe Premiere Pro which is same for the eMAM panel too.  The eMAM panel is HTML5 based, so it 

is only supported in CC versions of Adobe Premiere Pro. (To know more about your Premiere Pro version 

refer to Pg.110) 

 Premiere Pro CC 2017 [ 11.1.0 (222) Build WINDOWS/MAC] 
 Premiere Pro CC 2015.4 [ 10.4.0 (30) Build WINDOWS/MAC] 
 Premiere Pro CC 2015.3 [ 10.3.0 (171) Build WINDOWS/MAC] 
 Premiere Pro CC 2015.2 [ 9.2.0 (41) Build MAC] 
 Premiere Pro CC 2015.0 [ 9.0.2 (6) Build WINDOWS] 

 

Install eMAM Panel: You can install eMAM panel using any of the below two methods: 

I. Download and install latest eMAM Premiere panel from eMAM download.htm page or, 

II. Download and install eMAM panel from Adobe exchange website  

 

I. Download and install latest eMAM Premiere panel from eMAM 
download.htm page 

Once Adobe Premiere Pro is installed on your machine, get the URL/the name of the server 
running your eMAM system from your unit admin, IT department, or from the eMAM support 
team to insert it into the URL below.  

 http://eMAMServerName/eMAMDirector/Premiere/download.htm 

Follow the steps below to download and install the eMAM panel in Premiere: 

http://www.empressmam.com/
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                                                   Premiere panel download window 
 
 

Download A, B and C components as per your system requirement/specifications (as shown in above 
figure): 

A Click and download the latest Premiere panel (Windows/MAC) from the list: 

 eMAM Panel 3.8.10 for Premiere Pro CC 2017 [ 11.0.1 (6) Build WINDOWS/MAC]  

 eMAM Panel 3.8.10 for Premiere Pro CC 2015.4 [ 10.4.0 (30) Build WINDOWS/MAC] 

 eMAM Panel 3.8.10 for Premiere Pro CC 2015.3 [ 10.3.0 (171) Build WINDOWS/MAC] 

 eMAM Panel 3.8.10 for Premiere Pro CC 2015.2 [ 9.2.0 (41) Build MAC] 

 eMAM Panel 3.8.10 for Premiere Pro CC 2015.0 [ 9.0.2 (6) Build WINDOWS] 

B Download extendscriptprqe.txt: If you are installing Panel for the first time in your 
Premiere Pro CC version, download and place the 'extendscriptprqe.txt' file in the 
respective folder <C:\Program Files\Adobe\Adobe> Premiere Pro CC 2017 

 

NOTE: This file is a BLANK text file which is a requirement of Adobe. 

http://www.empressmam.com/
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C Download the Extension Manager command Line tool: Depending on where you are 
installing eMAM panel, click on Windows or MAC to download Extension Manager Command 
Line tool zip file. 

D   Help doc: Refer Help doc for any assistance with eMAM Panel installation. 

 
 

1) Windows :  

           Before doing eMAM panel installation, please ensure, Adobe Premiere Pro window is closed. 
 

1. Click on the Windows button and download Extension Manager Command Line tool zip file 

 

 
Extension Manager Command Line tool for Windows 

 

2. Go to the ExManCmd_win zip file downloaded location. Extract the contents from the 

downloaded zip. Copy the ExManCmd_win in Windows  to any system location. Press SHIFT+ 

mouse right click and select “Open command window here”. 

 

 

http://www.empressmam.com/
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1.3. Cmd.exe (Command Prompt) window opens up. 

 
 

2.4. Type exmancmd”space”/install”space” and drag and drop the eMAMPanel.zip file 

and press “Enter”. Please ensure Adobe Premiere Pro application is closed or terminated before 

updating eMAM panel. 

 

 
 

3.5. eMAM panel is now successfully installed on your machine and ready for use.          

http://www.empressmam.com/
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2) MAC : 

          To install eMAM panel in a MAC, follow steps below: 

 

1. Open eMAM download.htm page in MAC and download three main components as shown in 

below screenshot. 

 

 

 

 

1.2. Copy ExManCmd_mac to the desktop 

 

http://www.empressmam.com/
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2.3. Copy the eMAM panel.zip file also to the ExManCmd_mac 

 

 
 

3.4. Open the terminal 

 

 
4.5. Go to the Contents MacOS folder 

http://www.empressmam.com/
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5.6. Type cd in terminal and drag and drop the MacOS folder after a space to terminal 

 

 
 

6.7. Use the ExManCmd command to install or remove panel 

 

 
 

8. Use—install_for_all and drag and drop the eMAMpanel.zxpfile after a space 

 

 
 

http://www.empressmam.com/
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7.9. Type in the Admin credentials 

 

 
 

8.10. Successful installation message will be shown 

 

 
 

Upgrade/Install latest version of eMAM panel in Windows and MAC: 

a. Download the latest premiere panel from      

http://eMAMServerName/eMAMDirector/Premiere/download.htm 

b. Click on the Windows/MAC button and download Extension Manager Command Line tool zip 

file 

c. Follow 2, 3, 4 steps of the Extension Manager Command line tool (Windows and MAC) as 

described above. 

 

________________________________________________________________________________________ 

 

For additional help, please check the following link too. 

https://helpx.adobe.com/extension-manager/using/command-line.html  Or 

Refer Help doc on the top right hand side of eMAM download.htm page 

________________________________________________________________________________________ 

http://www.empressmam.com/
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II. Download and install eMAM panel from the Adobe exchange website  
 
eMAM panel is now available as an Add-on in the Adobe exchange website. You can now get the 
eMAM panel installed directly from the Adobe add-ons website. Login to the Adobe add on page 
with the same creative cloud Id which is used to open Premiere Pro. Also make sure Creative 
cloud Application is also running with the same id in the machine. 
 
 

https://creative.adobe.com/addons?pp=PPRO 
 

 
 
Search for word ‘eMAM’ leads to eMAM panel for Premiere. Click on the eMAM panel icon and 
download it. 
 

http://www.empressmam.com/
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_____________________________________________________________________________ 
 

For additional help, please check the following links too: 
https://helpx.adobe.com/extension-manager/using/command-line.html 
MAC Eg: 
IMacs-iMac:~ APPLE$ ./Exmancmd --install /Users/APPLE/Downloads/eMAMPanel.zxp 
For other version updates for Premiere, use the following links: 
Windows: 
http://www.adobe.com/support/downloads/product.jsp?product=98&platform=Windows 
Mac: 
http://www.adobe.com/support/downloads/product.jsp?product=98&platform=Macintosh 

______________________________________________________________________________________________ 

   

Uninstall/Remove eMAM Panel in Windows: 

a. Use ExManCmd”space”/remove”space”eMAM Panel 

 

b. Use ExManCmd”space”/remove for all eMAMPanel 

http://www.empressmam.com/
https://helpx.adobe.com/extension-manager/using/command-line.html
http://www.adobe.com/support/downloads/product.jsp?product=98&platform=Windows
http://www.adobe.com/support/downloads/product.jsp?product=98&platform=Macintosh


                                                                                                                                                                            User Guide 

                                                                                                                    

 

   
© 2017 Empress Media Asset Management, LLC 15 

www.empressmam.com 

 

 

 

 

Uninstall/Remove eMAM Panel in MAC 

a. Use ExManCmd --remove eMAMPanel to remove eMAM panel 

b. Use ExManCmd—remove_for_all eMAMPanel to remove panel for all users 

 

Note: A root user cannot uninstall eMAM panel using above remove for all command. 

 

Open eMAM Premiere Panel 

a. Launch Adobe Premiere Pro and create a new project. 

 
b. Under the Project and go to Windows>>Extensions>>eMAM and open the eMAM Panel 

 

http://www.empressmam.com/


                                                                                                                                                                            User Guide 

                                                                                                                    

 

   
© 2017 Empress Media Asset Management, LLC 16 

www.empressmam.com 

 

 

 

 

 

c. For the Premiere panel link, change the server name field with your eMAM Server name and 

click OK. Eg: http://adobe.emamonline.com/eMAMDirector/premiere/premierepanel.aspx 

 
eMAM Premiere panel link window 

From the 3.7.0.8 version onwards, eMAM panel will be by default redirected to eMAMOnline.com. 

Users can change the panel link to the corresponding eMAM server by clicking on the "Change Panel 

Url" button and change the eMAMOnline.com to the corresponding eMAM server name. 

 

d. Login to eMAM panel, using the eMAM login credentials provided by your eMAM unit 

administrator. 

 
   eMAM panel login window 
 

e. If a user profile is associated with multiple units, you will be asked to choose a unit at login.  

After the first login, it will automatically login with the same credentials. You can click on 

the logout button if you want to remove the credentials for the next login. 

http://www.empressmam.com/
http://adobe.emamonline.com/eMAMDirector/premiere/premierepanel.aspx


                                                                                                                                                                            User Guide 

                                                                                                                    

 

   
© 2017 Empress Media Asset Management, LLC 17 

www.empressmam.com 

 

 

 

 

 
Multi unit login window 

 

f. eMAM panel opens up Adobe Premiere as shown below. 

 

 
 
 
 
 
 
 
 
 
 
 
 
 

http://www.empressmam.com/
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eMAM Panel Overview 

Shown below is an eMAM panel window view. Details and description of various tabs and buttons are 

described below. 

 

eMAM panel window 

http://www.empressmam.com/
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1.  
 
 

 
 
   Function 
      tabs 

Import Using Import tab, you can import project/categories/assets 
from eMAM to Adobe premiere for editing. 

Archive Archives assets to the default archive locations, as set in 
Super admin. 

Restore Restore tab helps to restore assets from storage/archive. 

2.   
             Projects 

Displays projects, whether created in the eMAM interface 

or in the Premiere 

3.             Categories Displays categories created in the eMAM interface 

4.                 Assets Displays assets ingested into the eMAM interface 

5.        
     Adobe 
Projects tab 

Export Using the Export button, you can export edited projects 
from Premiere to eMAM. 

Save as Using the Save As button, an edited project can be saved 
to any desired location. 

6.                 
              Search 

Based on which tab is selected (Projects/Categories 
/Assets) and the search characters entered, search results 
will be shown.   

7.                
              Refresh 

                 

 
You can refresh the page to see the latest changes made in 
the eMAM interface. 

8.                Settings 

                  

 
You can make changes in the eMAM panel settings, as 
detailed below.   

       Export Preset settings  
You can configure various export formats.  

        Project File Storage 
              Settings 

You can specify where the project file is stored when it is 
exported to eMAM.   

9.                Logout 

                 

 
Click on this symbol to logout from the eMAM panel. 

10.   
 
   Check Out/Check In 

                     

You can check OUT a selected project.  Other users can still 

access the project, and can only save changes to the 

project as a different version.    

You can check IN a project so others can edit the current 

version.    This symbol is only visible under Projects 

tab.  

11.            Lock/Unlock 

            /  

You can lock/unlock any project by clicking on this symbol. 
A locked project cannot be imported or used by others. 
This symbol is only visible for Projects under Projects tab.  

http://www.empressmam.com/


                                                                                                                                                                            User Guide 

                                                                                                                    

 

   
© 2017 Empress Media Asset Management, LLC 20 

www.empressmam.com 

 

 

 

 

12.  

        List view  

You can view Projects/Categories/Assets in list view 
instead of folders.   

13.  

      Folder view  

You can view Projects/Categories/Assets as folders by 

clicking on this symbol. More information below 

14.  

                

 
Project created in Adobe Premiere. (.prproj) 

15.  

                

 
Project created in the eMAM interface. 
 

16.  

             

 
Shared Team Project 
 

17.  

                
 

 
Checked out eMAM project 

18.  

                

 
Locked eMAM project 

19.  

                

 
Checked out Premiere project 

20.  

                

 
Locked Premiere project 

21.  

            

A Sequence  

22.  

            

A Bin 

23.  

            

A Category 

http://www.empressmam.com/
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1. Projects Tab: This tab displays all the projects in the eMAM system. This includes 

projects created in eMAM interfaces, Premiere projects and Team projects. 

 

 
 

2. Categories Tab: This tab displays all the categories created in the eMAM system. 

http://www.empressmam.com/
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3. Assets Tab: This tab displays all assets in the eMAM system 

 

 

http://www.empressmam.com/


                                                                                                                                                                            User Guide 

                                                                                                                    

 

   
© 2017 Empress Media Asset Management, LLC 23 

www.empressmam.com 

 

 

 

 

 

4. Adobe Projects tab: This tab shows the currently opened Adobe Project with an 

option to Export and Save it.  

 

a. Export: You can export the current project from Premiere to eMAM. 

b. Save as: You can save the current project to any desired location. 

 
                                         Currently open project with Export and Save As options 

 

5. Search: Depending on which tab is chosen, you can use this function to search for projects, 

categories, or assets with the given name.  Type in the Search phrase and click on GO. 

 

 Search results under Projects tab     

 

http://www.empressmam.com/
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 Search results under Category tab 

      

 

 Search results under Assets tab 

 

 

Search will also display list of suggestions for the keywords entered. 

http://www.empressmam.com/
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6. Settings: The settings button allows you to make changes in eMAM panel settings like adding 

sequence export presets, Project file saving path etc. 

 

a. Export Preset settings: You can configure various export formats if you are exporting 

sequences with the current project. You can see the Export format and Export preset under 

the Select sequences option.  Premiere will automatically export an h.264 mp4 version for 

preview in eMAM, but will also export the sequence(s) in the format you select here. Under 

a particular format, you can create any number of presets from the settings window.  

Eg: If you select quick time for export format then the sequence will make a seq.mov 

format along with seq.mp4. 

 

 

Export panel settings window 

http://www.empressmam.com/
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To add a new formats, just click on  icon. Key in Preset name and Preset extension and 

click OK. 

 

a.b. Project File Storage settings: Using this option, you can define where the Premiere 

Project file needs to be stored when it is exported to eMAM.  You can select from any of the 

storage profiles configured in the Super Admin from a dropdown list.  

 

 

                                            Project file storage settings window 

 

All the storage profiles configured in Super Admin console will be available under storage 

profile dropdown list. You can also create a separate Storage profile for project storage 

under storage configuration in Super Admin console and all Premiere projects files will be 

saved in this location after export. 

 

Using Localize option, eMAM users can work in an environment without direct connection to 

the eMAM central storage. Refer Localize section on Pg.30 for more details 

This requires some changes in Default panel settings: 

 

• Central path for projects - eMAM storage location for project files 

• Local path for projects - Store the importing project locally. 

• Local path for Media - Store the assets in the importing project locally. Multiple 

users can point to the same ‘Local path for media’ assets, so that they don’t need to 

localize the asset which are already localized by another user. 

• Local path for export - Store the exporting project file and its contents before 

uploading to cloud 

• Overwrite localized assets - Overwrite options for media that already exist in Local 

path: Always, Never, If size is different, If created date is different. 

If a user Imports an asset which already exists in ‘Local path for media’, eMAM will 

either replace it or use the existing asset in the ‘Local path for media’ depending up 

on the ‘Overwrite localized assets’ flag selection. 

 

http://www.empressmam.com/
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: Red icon indicates no connection to the mentioned UNC path 

 : Green icon indicates connection established with the mentioned UNC path 

 

 

b.c. Default Panel Settings: Here you can the set default values for proxy options, 

sequence export options etc. which will be used in the Metadata popup window during 

export. 

 

 
Default Panel Settings window 

 

You can set default values for below and click OK: 

a. Select all files by default (checkbox) 

b. Select all sequences by default (checkbox) 

c. Default Proxy options: You can also set your preferred ingest below options as 

default: 

 Trancoding type: Media encoder or eMAM Managed Transcoding.  

 Transcode Preset: Select any option from dropdown list 

 Ingest Profile: Select any option from dropdown list 

d. Sequence Export Options: You can set preferred sequence export options: 

 Export format: Select any option from dropdown list 

 Export Preset: Select any option from dropdown list 

: Red icon indicates no connection to the mentioned UNC path 

 : Green icon indicates connection established with the mentioned UNC path

http://www.empressmam.com/
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7. Folder view: You can view Projects/Categories/Assets in folders/thumbnails by clicking 

on  symbol. To revert back to list view, click on  symbol. 

 

      
Folder view of Projects in eMAM panel 

       

http://www.empressmam.com/
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8. Localize: Using Localize option, eMAM users can work in an environment without direct 

connection to the eMAM central storage. Now you can work from home or during travel etc. and 

can share your work with people at different locations. Project elements will link back to the 

eMAM storage only when the project is exported back to eMAM 

This requires some changes in Default panel settings described in Page. 

 

eMAM panel workflow using Localization: 

a) Select a Project/category/asset and click on Import button. Project local path 

and asset local path is already defined in the Settings window 

 

 

Project Import with Localize option 

 

Category Import with Localize option 

http://www.empressmam.com/
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Asset Import with Localize option 

b) If Project file or any assets cannot be accessed from the client machine, panel 

will show the waring message: 

 

c) However, if the project file and all the assets can be accessed from the client 

machine eMAM panel will start to download the assets to the local folder. Once 

all the assets are downloaded completely eMAM panel will link the assets to the 

imported project 

 

d) Localized assets gets downloaded in ‘ Local path for media’ 

 

e) If any of the assets already exist in the download location, eMAM panel will find 

that by using the UUID name comparison, and will either use the same asset or 

replace them, depending on the “Overwrite localized assets” value (Never, 

Always, if size is different). 
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f) Downloaded and linked file details will be saved in an xml file along with the 

Project file. 

g) When the project is exported back to eMAM, eMAM panel will link the assets to 

central storage location. 

 

 

 

 

8.9. Checked Out: When you import any project to Premiere, it gets automatically 

checked out (not for Adobe Premiere Pro CC) with this symbol /  which means at a 

time only you will be able to work on that particular project in Premiere.  Other users will NOT 

be able to import the same version of the project.  

 

 
Import options window with Check Out option 
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9.10. Checked In: When you export a project to eMAM, it automatically gets checked in, 

so other users can now import this project and work on it. This option will be checked by 

default and user cannot change that. This ensures that whenever export happens the project 

gets checked in and a new version is created. 

 

 
Option to check in during Export 

10.11. Asset Options window: When you double click on any asset under 

Projects/Categories/Assets tab, asset options window pops up. Various asset options tabs like 

Preview, Metadata, History, Comments, Approval, File versions are available. 
 

 
                                                                 Asset Options window 

 

a. Preview tab: Users can preview any asset individually and view its properties like name, 

status etc. 
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b. Metadata tab: Users can see all metadata details of the asset like Info, Embedded metadata, 

Custom metadata, and tags under different fields. They also have the option to edit metadata 

details of the asset. 

 
 

c. History tab: History tab displays asset details and entire history of functionalities used on the 

asset. It displays Date of Actions, Action Performed, User Name and id of the user who 

performed the action.  
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d. Comments tab: Displays user name, comment written by the user and date when the 

comment was written. Comments written on different interfaces are displayed here. 

 
 

e. Approval Tab: Users may require asset to be approved by another person, internal or external 

to the organization. An asset can be sent for approval to another eMAM user (internal approval) 

or externally as a link to someone who has no access to eMAM (external approval). 

 
 

f. File versions: File version displays all the different versions created for the same asset. 

Therefore, users have option to select any version they want. 

 
 

 

 

Main functions 
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A. IMPORT 

The Import function can be used to import eMAM managed content (Asset/Project/Category) from 
eMAM to a Premiere project located in a client machine for editing works. It can be used to import an 
entire project or bins, categories, assets or sequences (rough cuts) created in eMAM.  During import, 
the assets added to your Premiere project will be linked to the central eMAM storage location. In order 
to import the assets to the Premiere client machine, Premiere client location should have the network 
access permissions to the eMAM storage location. If you are working in a MAC, eMAM storage location 
should be mounted as a volume to the Premiere machine. 

 Project: Projects can be imported from eMAM to Premiere for editing. Select the Project 

(Premiere Project  or an eMAM Project ) from the Projects tab and click on Import. There 

can be 2 types of project imports. 

 Import of eMAM project which is created in eMAM and does not have a project file 

(.prproj) associated with it. 

 Import of Premiere project which was exported to eMAM using eMAM panel. During 

import a copy of the project will be created in the destination folder with the assets 

linking to eMAM storage locations 

There are various possible import scenarios: 

1. Import project with checkout option enabled: In the Projects tab, click on the project 

which needs to be imported to Premiere. Click on the Import button. A new Import options 

window pops up. Fill in all the details and enable Check out and Localize button. Now this 

project will be checked out and will be visible to others users as  or . 
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      Import project with check out option enabled 

2. Import project without check out option enabled:   You can import any project to 

Premiere without checking the Check out option in Import Options window. 

 
    Import project without check out option enabled 
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3. Import of an already checked out project by another user: When you try to import any 

project already checked out by another user, a pop up window asks you to select the 

version of that project that needs to be imported.   Choose and click OK. 

 
           Window listing versions of that project 

Then Imports options window pops up. Fill in the details and click OK. 

 
   Import options window 

4. Import different version of a project: If any project has multiple versions, when you click 

on Import, a new window will pop up with different version details listed for that project. 

You can select the version that needs to be imported to Premiere and click OK. 
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Window listing versions of that project 

5. Import project to the desired location in a local machine:  You can import any project to 

your local machine by choosing the desired location path using Browse of Destination 

folder in the Import Options window. 

 
                    Option to import project to desired location in a local machine 
 

6. Option to select mezzanine file format for assets during import: You can select 

mezzanine (intermediate/proxy edit) file format of an asset during import by linking assets 

to other mezzanine platforms (formats) in the Import Options window. If you have an ingest 

profile which has a mezzanine platform configured, then it will be selected by default. This 

will import the mezzanine file format of the assets to the Premiere project. If there is no 
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mezzanine format available for an asset, then the original format will be imported, even if 

you select a mezzanine platform. 

 
Mezzanine files format selection for assets during import  

7. Import of process from source assets: You can import assets ingested with process from 

source option, so they will be transcoding without moving them. 

 

 Category: Categories under categories tab can be imported to Premiere. Select the Category 

which needs to be imported from Category tab and click on Import. Import can happen for: 

o Import of Single category: A single category can be imported by clicking on that category 

and then the Import button. A Category Import Options window pops up. Fill in the details 

and click OK to import that category to Premiere. 

 
Category Import options window 

o Import of Multiple categories: Multiple categories (category and its sub categories) can be 

imported to Premiere. 
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Import of Multiple categories 

o Import of assets inside category: You can import assets inside categories to Premiere. 

o Categories get imported as bins: Categories imported from eMAM come in as new bins 

under the current project. New categories will not be created.  Under the Categories Tab, 

select the category which needs to be imported to Premiere and click Import. 

 
                                           Category Import options window 

Category Import options window pops up.  Fill in the necessary details and click OK. 
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                                     Category gets imported as Bin to Premiere 

The category and its sub categories get added to the current project as bins. 

 
                                           Category gets imported as a Bin in Premiere 

o Option to select mezzanine file format for assets during import: You can select a 

mezzanine file format of an asset during category import by linking assets to other 

mezzanine platforms in the Category Import Options window. 

 
                   Mezzanine files format selection for assets during category import  
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o Import of process from source assets: Users can import assets ingested with process from 

source option during Category import to Premiere. 

 Asset: Assets under assets tab can be imported to Premiere. Select the asset which needs to be 

imported and click Import. Various scenarios during asset Import are: 

o Import of single asset: An asset can be imported to Premiere by selecting that asset under 

Assets tab and clicking on Import button. Asset Import Options window opens up. Fill in the 

details and click OK. 

 
Asset import options window 

o Import of multiple assets: Multiple assets can be imported to Premiere. 

 
Multiple assets import window 

o Option to select mezzanine file format: If assets are ingested to eMAM with other platform 

options (mezzanine files), you will have the option to link to those other platform files 

during import. 
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o Marker regeneration from eMAM to Premiere assets: Markers added to assets in eMAM are 

recreated into the Premiere assets after import with marker name, description and duration 

details. Markers imported from eMAM will come with a suffix <<eMAM-Marker>>. 

 

 

All the assets imported from eMAM to your Premiere project will be linked directly to the 

new project/ project version.  They will not be ingested again. 

o Import of process from source assets: The eMAM panel supports the importing of assets 

processed (transcoded) from their source location. 

 Bin: Select a bin inside a project or a bin inside another bin and click on Import. Import will 

create the same bin structure in the existing Project. 

o Import a bin containing assets:  You can import a bin which has assets inside. A Bin Import 

options window will pop up. 
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            Bin import options window 

o Import a bin which has multiple bins inside: You can also import a bin which has multiple 

bins inside. Select a bin inside a project or a bin inside another bin and click on 

import. Import will create the same bin structure in the existing Project. 

 
Import of multiple bins 

o Import of process from source assets: Bins with assets processed from source can also be 

imported to Premiere.
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 Sequence: Select a sequence under a project and click on Import. Sequence import options 

window pops up. 

 
                                      Sequence import options window 

 Subclips and Markers:   Subclips and markers can be imported to eMAM panel. Subclps 

when imported will reflect as markers in a video file. Set In point and Set Out point of subclips will 

be marked as two separate markers in the video file. But if any Project/ category is imported, 

subclips under them do not get imported to eMAM panel. Markers on the other hand gets imported 

to eMAM panel both in case of asset import or project/category import.  

1. Select any asset with subclips under Assets tab and click on Import.  

2. Subclips and markers in the video asset gets imported to eMAM panel as markers(See Below) 

3. Subclips can be identified with their description <<eMAM-subclip>> and two different Set In 

and Set Out points. 

 

 

http://www.empressmam.com/


                                                                                                                                                                            User Guide 

                                                                                                                    

 

   
© 2017 Empress Media Asset Management, LLC 46 

www.empressmam.com 

 

 

 

 

 

After import of the asset, when you compare Set In and Set Out points in eMAM Director and Adobe 

Premiere, it would be the same. 
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B. EXPORT 

The export function can be used to export Premiere projects and their contents from Premiere to 

eMAM. This helps to upload a completed Premiere project and its contents to the centralized eMAM 

storage for sharing, review and approval etc. by creating the same project structure in eMAM. You 

can create a new Premiere project and export it to eMAM.  You can import an existing Project from 

eMAM, edit it, and then export it back to eMAM as a new version of that project.  You can also 

import an existing project and export it back to eMAM as a new project. Premiere user should be 

associated with an OrginalAndProxy/ManagedTranscode ingest profile in order to export the 

contents to eMAM using eMAM Panel. You can export assets from a Mac to ingest folders with local 

folder configurations too unlike earlier eMAM versions, where you could export from Mac only to 

Network/Mac configured ingest profiles. 

 Project 

Premiere projects exported back to eMAM can contain multiple bin structures with assets and 

sequences.  The same asset can be imported to multiple bins from eMAM and can be exported 

back. Assets imported from eMAM which have special characters in the name (such as / : * ?  " < >  

|) can be exported back to eMAM. 

o Export of Project checked out during import: When you export a project back to eMAM 

that you checked out during import, then an Update project window will appear.  You can 

save the changes as a new version of the project.  You can also Check In the project and 

add version notes. 

 
           Import options window with Check Out option 
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Check in option window during export 

o Export of Project not Checked out during Import: After editing, if you try to export a 

project for which the Check Out option was disabled, eMAM will ask to save it with a new 

project name if the same name already exists in eMAM.  

 
                                      Import option window with check out option 
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    Create new project window 

Enter new project name and click OK. Project Metadata window pops up. In this window, you 

can fill in all metadata details for the new project. 

 
     Project Metadata window 

 Select Files: Select the files in the project which needs to be exported back to eMAM. 

All the assets imported from eMAM to the Premiere project will be marked with an "e" 

symbol in front of the select files tab. 
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Project metadata window- Select files 

 Select Sequences: Select the sequences which need to be exported to eMAM. All the 

selected sequences will be ingested to eMAM each time a project is exported.  You can 

select the export presets if you want to create an extra format for the rendered 

sequence in addition to the mp4 proxy file created for eMAM preview.  Authorized users 

can download these formats from the eMAM director browse interface with the 

download option. (For more info on Export Preset settings, please refer Pg:16) 

 
                                                            Project metadata window-Select sequences 

 Select eMAM Proxy options:  eMAM needs a proxy copy for preview.  You can decide 

whether this is made locally on your desktop using Adobe Media Encoder or made on the 

eMAM server (eMAM Managed Transcoding). In order for you to export from your 

Premiere panel, your system administrator/IT staff needs to set you up with eMAM 

ingest profile that is either orginal+proxy or managed transcoding.   There should be 

either a network or a local folder path associated with the ingest folder for exporting 

from a Windows machine. Similarly, there should be either a network or a Mac path 

associated with the ingest folder for exporting from a Mac machine. 
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                               Project metadata window-Select eMAM Proxy options 

 Project Details: Under this tab, you can view the project details such as project name, 

description, author, and version notes. 

 
                                           Project metadata window-Project details 

 Categories: Under this tab list of categories will be displayed which can be selected for 

this new project. 

 
                                              Project metadata window-Categories 

 User Tags: Select from the list of Tags created in the eMAM interface or you can add a 

new tag. 

http://www.empressmam.com/


                                                                                                                                                                            User Guide 

                                                                                                                    

 

   
© 2017 Empress Media Asset Management, LLC 52 

www.empressmam.com 

 

 

 

 

 
                                              Project metadata window-User tags 

 Custom metadata: Fill in all the required custom metadata fields for the new project 

and click ADD to start the Export 

 
                               Project metadata window-Custom Metadata 

 

It will take some time to export the sequences (Media encoder window opens up and 

encodes the jobs and once this process is complete, control is passed on to Premiere). 
 

                                       
                                  Media encoder opening window 
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Media Encoder exporting window 

 
Please wait window 

The edited project will now be displayed as a new project under the Projects tab in the 

eMAM panel. 

 
          eMAM panel displaying new project after export 

o Export of a project already checked out by another user: You can import a project that is 

already checked out by another user: 
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                  eMAM panel window displaying project checked out by another user 

After editing, if you try to export it back to eMAM, the warning below pops up.  It indicates 

who checked out the project and asks if you want to save it under another name.   This 

avoids editing conflicts on the same project.   

 
      Message displayed when user tries to export project checked out by another user 

You can either cancel the export or click OK and create a new project. 

 
                                        Create new project window 
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 Category 

o Export of categories imported as bins: Categories imported from eMAM come in as new 

bins under the current project. These bins get exported as bins to eMAM. Bins and the 

contents inside them will also be exported as the bins in the project. If you want to 

associate any of the exporting assets with a category, you need to select those categories 

from the metadata window under categories tab. 

 

 
                                           Category gets imported as a Bin in Premiere 

Click on the Export button under projects tab in the eMAM panel. Projects and bins get 

exported to eMAM. Imported categories get exported as bins and not as categories. 

 

C. ARCHIVE/RESTORE 

Archive can be performed for projects, categories and assets. Click on a project/bin, a category or 

assets and click on the Archive button.  The Archive-Restore status window pops up, displaying the file 

name and its status. 

  
                                            Archive/Restore status window 
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Adobe Team Projects 

Team Projects’ is a hosted services in Adobe Creative Cloud that allows the editors and motion 

graphics artists with Team or Enterprise license to collaborate and share the sequences/compositions 

in real time. Team Project features like version control, conflict resolution, sharing sequences and 

compositions are built into CC 2017 versions of Premiere Pro, After Effects and Prelude. Use Adobe 

Team projects to work simultaneously on shared video projects.  Editors can share a team project 

without fear of overwriting someone else’s efforts. Adobe Team Project is saved in Creative Cloud 

database for collaboration purpose. 

 

Open Adobe Team Projects 

a) Create New Team Project using the “New Team Project” button in in the Manage Team 

Projects window or from the menu option File->New->Team Project (Beta) 

 

b) Project Name and Team Members can be added from the New Team Project window. 
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c) Open existing Team Project using Premiere Pro-> File -> Open Team Project (Beta) option. 

 

d) Give your team project a name and invite collaborators to work on it by clicking Edit, 

adding their email addresses to the queue, and clicking Invite. Click OK to close the dialog 

box. All collaborators will receive a notification in their Creative Cloud Desktop application, 

where they can either accept or reject the invitation. 
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e) An existing project can be selected and opened from the Manage Team Projects window. 

(Make sure you are connected to Creative Cloud). 
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Overview of Team Projects tab 

By default, eMAM panel will have the Team Project tab opened when the panel is loaded inside 

a Team Project and will have Get Media and Share Media options.(No Export and Save as 

options). 

 

 Get Media : Import assets from eMAM and Local using Get Media option. This 

will sync the media from eMAM system to the currently opened Team Project.  

o If the media is available in eMAM central storage accessible by the Premiere Pro 

system, ‘Get Media’ option will make the link to the media.  

o If the eMAM managed storage location by eMAM is not accessible from Premiere Pro, 

eMAM panel will try to download the media to the local storage location configured 

in the panel using localize option. Download progress will be displayed in a pop-up 

window. Once the media is available in the local storage location, eMAM panel will 

automatically relink the media for the respective assets based on the UUIDs in 

eMAM. 

      

o If the media used inside the Team Project is still under progress when user is trying 

to do the ‘Get’, warning message will come showing the status of the pending assets 

being ingested into eMAM. 
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o Once the process completed, eMAM panel will link the media automatically either to 

eMAM central storage or to the downloaded assets.If any of the media is not shared 

to eMAM, user may inform the team member who have added those media to the 

Team Project to share them to eMAM, using eMAM panel ‘Share’ option. 

o If the Team Project is not available in eMAM, Get option will be disabled.  

 

 

 Share Media : Share option will sync the media from Team Project to eMAM. 

This option will upload the new media used in Premiere Project to eMAM. Users will get the 

option to select Media, encoder or the server based transcoder to make proxy. If the team 

project does not exists in eMAM, by clicking on Share button will automatically create the 
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project in eMAM. eMAM core product will be changed to handle the Team Project with 

different logo and settings.  

 

 Convert Team Project as a Premiere Project and upload to eMAM (checkbox): Enable 

or disable it. 

 Select Files 

 

 Select Sequences. 
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 Select eMAM Proxy options 

 

 Categories: Select categories. 

 

 User Tags: Select tags. 

 

 Custom Metadata: Enter custom metadata details and click Add. 

 

 Project gets saved in eMAM as share team project. 
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User has to wait for the Share process to finish before sharing the project changes to 

another team member through creative cloud otherwise the other team member will not be 

able to access the new media.  

 

In order to avoid this delay, we always recommend to ingest the media to eMAM system and 

import that media using the eMAM panel. 

 

Share Adobe Team project changes by choosing Edit > Team Project > Share My Changes. 
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 Assets Tab 

User will get the option to import the original or mezzanine media into the currently 

opened Team Project. If the Premiere Pro CC machine is not connected to the central 

storage, localize option can be used to download the media to the workstation. 

 

http://www.empressmam.com/


                                                                                                                                                                            User Guide 

                                                                                                                    

 

   
© 2017 Empress Media Asset Management, LLC 65 

www.empressmam.com 

 

 

 

 

 

 Categories Tab 

User will get the option to import the categories as bins into the currently opened Team 

Project.  Additional options are included to link to the Original or Mezzanine media with 

localize option. 

 

 

 Projects Tab  

A new icon will be used to differentiate the Team Project, eMAM Projects and Premiere Pro 

projects. If a user try to import a Team Project from eMAM Panel, options will displayed to 

import the project as Team Project or Premiere Project.  
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If the user chose the ‘Team Project’ import option, user will be instructed to use the 

Premiere Pro to open the team project (this is because there are no APIs available to open 

a team project form the Panel). If the editors are working on a centralized storage 

environment, Premiere Pro will automatically link to the media. If Premiere Pro cannot 

connect to the eMAM managed storage location, ‘Get’ media option in the panel can be 

used to localize a copy of the media. ‘Get’ option can be also used to link to the newly 

ingested media in eMAM.  (Refer user case 3 below) 

 

 

 

If the “Premiere Project” import option is chosen, eMAM will open the last snapshot of the 

Team Project as Premiere Project. This options is useful to share the Team Project to non-

team members with individual Premiere Pro CC licenses. (Refer use case 4 below). 
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 Process Flow: 

Get Media 

 

a. On Click of ‘Get’ media button, panel will search for the currently opened Team Project 

in eMAM. (Get option will be disabled if the Team Project does not exists in eMAM) 

b. Panel will identify the missing assets and newly added assets. 

c. A message box will be displayed with the option to link to the Original or Mezzanine 

copy. Localize option can be used if no access to central storage. 

d. Display the progress bar to show the progress 

e. Once the process completed, eMAM panel will link the media automatically either to 

eMAM central storage or to the downloaded assets. 

Share Media 

 

a. On “Share” media button click, panel will create a new project entry in eMAM with 

project type as Team Projects (database/gateway/director changes required to handle 

the team projects) 

b. Like a normal premiere project all the project details and version details will be stored 

in eMAM. 

c. Premiere Pro keeps a local snap-shop of the Team Project as .prproj file in the local 

workstation and eMAM take a copy and upload that to the central storage. 

d. The Metadata window (current export window) will not be having the current project 

details tab 

e. By clicking on the Add button on the Share window (current export window) the selected 

files and the sequences will be copied to eMAM ingest location in order to sync with 

central storage. 

f. Ingest manager will pick up the uploaded files one by one and add them to the Team 

Project in eMAM 

Once all the assets are ingested to eMAM we can see them mapped under the Team 

Projects in eMAM Projects widget and the Projects tab in eMAM Panel. 
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eMAM/Adobe Premiere Workflow 

Using Adobe Premiere Pro, you can now import content, edit, and then export it back to eMAM.  

       
                                            eMAM/Adobe Premiere workflow 
 
 

Basic Import and Export steps for a simple workflow: 

1. Create a new project or open an existing project in Adobe Premiere. 
2. Open up eMAM panel: click Windows- Extension –eMAM. Login with username and password 

from admin 
3. Once logged in you will see all the Projects/Categories and Assets you have permission for. 
4. Select the Project/Category or assets you wish to import and click Import 
5. Make edits using Adobe Premiere. 
6. When ready, you can send your Adobe Premiere project into eMAM storage by clicking on Export 
7. eMAM will detect whether any project with same name already exists in the storage. 
8. If yes, you may update with as a new version the project or rename the project. 
9. eMAM will prompt you to enter metadata info for the project and its assets 
10. eMAM detects if assets are already managed in storage and whether new media have been 

added. 
11. eMAM will prompt whether u would like to export the new assets into the eMAM storage. If so 

eMAM can trigger the proxy transcode process. 
12. eMAM can also trigger premiere sequences for preview. 
13. The chosen sequences will b exported to eMAM as mp4 files.Additionally eMAM allows for 

project lock in, check in and checkout options. 
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Detailed Import and Export steps- eMAM to Premiere: 

eMAM: 
1. In the eMAM Director Interface, create a new Project to manage media going to Premiere. Add 

files which need editing in Adobe Premiere. 

 

 
                                      Add new project window 

2. Create new bins under the project and drag assets to their appropriate bins (Videos, Audio…) 

 
                                                            Add new bin window 

3. Create a new sequence for Rough Cuts – (You need permission for the Timeline and Timeline 

Preview Widgets).  
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                                         Option to create sequence 

 

 
                                       Create sequence window 

 

4. Drag the assets and sub-clip media, you want in your timeline into the Timeline Widget and 

Click “Save”. To preview this time line, you can open the “Timeline Preview” widget.   

 

 
                           Sequence created saved and displayed in Timeline and Timeline widget 

 

5. Project is now ready to be imported into Adobe Premiere Pro. 
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Project tab displaying Projects/bins and sequences 

 

Adobe Premiere Pro: 
1. Launch Adobe Premiere Pro. 

2. Open the eMAM panel in Adobe Premiere by clicking Windows>Extensions>eMAM 

 

 
                                                Adobe Premiere window 

 

3. Login using the eMAM login credentials 
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                                eMAM panel login window 

 

4. If you belong to more than one unit, then select your unit. For any clarification, you can 

contact your unit administrator. 

 
                              Multi unit selection window 

 

5. The eMAM panel opens up and displays all the projects created in both eMAM and  

Premiere under the Projects Tab. 
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               eMAM panel displaying project created in eMAM Director interface 

 

6. From the Projects Tab, select the eMAM project created in eMAM and Click “Import”.  

 
                                      Import process in eMAM panel window 

 

7. The Import Options window pops-up. Make sure the location of the Premiere project is correct 

and select Link to assets “Original Media”.  The Checkout option will be automatically selected 

(Need to manually select Checkout for Adobe Premiere Pro CC) 
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                                            Import options window 

 

8. The Project Media and Sequence will appear in the Premiere interface with the rough cut 

sequence on the timeline. If you have added markers in the eMAM Interface, they will also 

appear in the Timeline and Media Player section in the Premiere. 

 
                                            Window displaying projects imported to Premiere 

 

9. Begin your edits and add new media from external drives or from the eMAM Panel (Categories 

and Single Assets) 

10. When editing is complete and the Sequence is “Ready for Review”, save the project, then click 

on “Export” to send all edit references back to eMAM. 
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           Export and Save as option under currently open project in Premiere 

 

11. An Update project window will pop up to save the changes as a new version of the project. You 

will also have an option to enable Check In and add Version notes. 

 
                                                         Update project window 

 
                                            Project metadata window 
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Fill in Project Metadata details for the new version. During export, eMAM will make proxy 
versions for preview for all the new local assets and all the sequences.       
Project is now added as a new version of the same project. 

 
12. Within the eMAM Director Interface, the new Premiere project will appear in the “Projects” 

widget window. You can open the “Project Versions” Widget in your workspace to see both the 

eMAM and Premiere project versions. 

 

 
              Project version tab displaying different versions of a project 

 

13. In Premiere, editors will be able to see the Premiere Project in the eMAM Panel and import it 

into their workstation and manage the Project Versions 

 
                            eMAM panel displaying updated version of the Project  
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Sample Workflow Scenarios 

I. Workflow 1: Import assets from eMAM/local drive and export the project to eMAM 

 

1. Create Project:  Create a new premiere project  e.g.: workflow1 

 
 

2. Import assets 

2.1 To import assets already existing in eMAM,  go to assets tab,  search for the asset, 

select it and click on Import 
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Select the Appropriate option from the “Link Assets To” option depending on whether 

you need to link with the original media or the mezzanine format. In this case, we have 

selected Mezzanine Format Premiere  

 

 

This will import the ‘F1break test’ asset from eMAM to Premiere project workflow1 

 

You can import multiple assets from eMAM like this, but make sure, the machine in 

which Premiere pro is running is able to connect to the eMAM asset storage location. In 

case of a MAC, you need to mount the storage volume to the machine. 

2.2  Import Assets from local folder: Under Premiere projects tab, right click and select 

“Import”. Select the file from local desktop. 
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Now you have two assets in the project ‘F1break test’ and ‘Regera at Geneva 2016.mp. One 

imported from eMAM and the other one added from local drive. 

 
3. Now create a sequence and do some editing on those clips 

 

       Once you are done with editing, you can export the project to eMAM. 

4. Export Project to eMAM: Go to the Project tab in the eMAM panel and click on “Export” 
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5. Project Metadata window will open up to confirm below details: 

 

 

5.1  Select Files: Based on which are the files and sequences that needs to be exported as 

part of the project in to eMAM, select those files. Under Select Files tab, we can see 

that there are the two assets in the Premiere project: one with an “e” symbol which 

means the asset is already there in eMAM and the other one is a new asset added from 

the local drive. eMAM panel will not list the effects, title etc. in the select files tab. 

 
5.2  Select Sequences: Here you can see the new sequences that were created in the 

project. There is also an Export Format and Export preset options, which can be used to 

create the highres sequence format after the final editing. 
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5.3  Select eMAM Proxy options: Here you can select how to create the proxy files for 

eMAM. You can either select : 

o Adobe Media encoder: This will use the editing Premiere pro machine for 

creating the Proxy. (In this case, we can use only the “OriginalWithProxy” ingest 

profile) 

o eMAM Managed Transcoding : In this option eMAM managed transcoders will do 

the Proxy creation. (In this case, we can use only the “ManagedTranscode” 

ingest profile so we have selected the “eMAM managed Transcoding” option to 

create Proxy files). Here we cannot specify the “Transcoding preset” since the proxy 

dimensions depend up on how the transcoder is configured.  

 
5.4  Project Details: We can add other project details in Project details 

 
5.5  Categories: Similarly select the Categories to which the newly added assets needs to 

be added, 

5.6  User Tags: Select tags that needs to be associated with assets. 

5.7  Custom Metadata: Select custom metadata details. 

 

After adding all the necessary details click on “Add” to start the export. (Make sure you select the 

files and sequences that need to be added to eMAM before clicking on “Add”). It will take some time to 
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export the sequences (Media encoder window opens up and encodes the jobs and once this process is 

complete, control is passed on to Premiere). and move the files to ingest folder. 

                                  
                                              Media encoder opening window 
 

 
Media Encoder exporting window 

 

 
Please wait window 

For any more editing on this project, you need to wait till the assets get ingested to eMAM. 

6. Use the eMAM Director Dashboard to see the asset ingest status. Once the export is completed 

added items are displayed in the dashboard. Only the asset added from the local drive is listed 

here, since the other one already exists in eMAM. 
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7. After the items are ingested successfully, you can see them under the project in eMAM 

Director and preview the new asset by clicking on the “PREVIEW” widget 

 

Also click on the sequence to preview the sequence in the “TIMELINE PREVIEW”   widget. 

 

II. Workflow 2: Import already existing project from eMAM, edit and export it back as a 

new version 

1.  Select the project and click on Import. 

 

 

2. Import Options window opens up. Select the “Check Out” option if we want to export the 

Project as a new version. Also select the local folder to which the Project gets imported. 

And the “Link Asset To” option to mezzanine or original file 

http://www.empressmam.com/


                                                                                                                                                                            User Guide 

                                                                                                                    

 

   
© 2017 Empress Media Asset Management, LLC 84 

www.empressmam.com 

 

 

 

 

 

 

3. If the project is imported from a location other than from where the new asset (this case 

“Regera at Geneva 2016”) was added to the project during the first import, a pop up like 

this will be shown and we need to click on the cancel button, so that eMAM panel will 

automatically re link the asset to the eMAM storage. 

 

 

4. Once the import gets completed all the assets will be linking to eMAM storage locations. 
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5. Do some editing: Here we have not added any new asset but have just done some effects 

and added a new title. So there are no new files, only sequence is edited. 

 

 

6. Export the project as a new version to eMAM: Select Project window and click on Export 
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                       Add the Project version comments and click “OK” 

 

 

7. Project Metadata window pops up:  

  Select Files: Here we can see two files having the “e” symbol, meaning that 

both the files are from eMAM, select them in order to add them to the new 

project version. 
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 Select  Sequences 

 
 

 Select eMAM Proxy options:  Select the ingest profile and click on “Add” 

 
 

8. Monitor the dashboard to see file is ingested successfully to eMAM. 

 

 

 

9. Once the processing is completed, you can see the new sequence in “TIMELINE PREVIEW” 

Widget by clicking on the sequence in the project. 
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Also you can see that there are two versions for the Project is create by looking at the 

“PROJECT VERSIONS” widget 

 

 

III. Workflow 3: Import already existing project from eMAM, edit and export it back as a 

new version with an incomplete edit so that another editor can work on the same 

project 

 

1. Import the Project: In this case, since there are more than one versions of the file you can 

select the desired version from the pop up 
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2. Import Options window pops up: Select ‘Check Out’ and select desired options and click 

OK. This will import the second version to the Premiere. 

 

 

3. Do some editing: If the editing at workstation 1 is not complete and someone else at work 

station 2 needs to work on it, current user needs to export the project back to eMAM. 

 

 

4. Since you have checked out the project, other users cannot import the project, and also 

without exporting the project back to eMAM as a new version the next editor cannot get the 

changes done by workstation 1 

 

 

5. Export the project back to eMAM: But this time user doesn’t need to ingest the sequence 

in to eMAM, since it is still needs to be worked on. 
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6. Project Metadata window: 

 Select files:  Select all the files 

 
 Select Sequences: Have not selected any sequences in this case as shown below. 

 
 Select the ingest profile and click on “Add” 

 
7. A new Project version created in eMAM without the sequence in it. 
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IV. Workflow 4: Import already existing project from eMAM, edit and export it back as a 

new version with the final edit 

 

1. Import the project: Select the version of the project and import it. 
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2. This will import the last unfinished project to the work station 2 

 
3. Editors can do more editing and export the final work to eMAM. In this case we will import a 

new file from eMAM for the final edit, 
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4. Do the editing: 

 
 
5. Export the Project back to eMAM 
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6. Since the new asset was imported from eMAM all the 3 files will be shown with an “e” 

symbol  

 
7. Since this is the final version of the edited sequence, you may need to export it with a High 

resolution original file. This is where the Export format and Export presets can be used for. 

8. By default, eMAM panel has some Export presets, which can be changed or user can add 

new formats based on their requirement. These changes can be done in the settings 

window, “Export Preset Settings” window. 
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All the default options can be removed or edited and new formats can be added too. 

9. In this case, we have chosen HD 720p mov as the highres original for the sequence. 

 
10. Now select the ingest profile and click on “Add” 
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11. It will take some time to export the sequences (Media encoder window opens up and encodes 

the jobs and once this process is complete, control is passed on to Premiere). Highres mov for the 

sequence is now created. 

12. In the dashboard, you can see that the sequence has a .mov output file 

 
 

13. If you check the other 2 sequence ingest in the 1st and 2nd version, you will notice that the 

sequence output file was a .mp4 file 

14. Once the ingest is completed, you can see the final sequence in the “PROJECT” widget, and 

also all the four versions in the “PROJECT VERISON” widget 
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15. Click on the sequence and you can see the final preview in the “TIMELINE PREVIEW” widget 

 

 

16. Also you can see all the exported sequences as separate single assets in the “BROWSE” 

widget too. 
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17. Users can download the original high resolution Sequence file from the “BROWSE” widget 

download option. 
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 Tips - Import and Export workflow in Premiere Pro CC 

a. If you import an eMAM project, and want to export that project back to eMAM after editing, 

create a new Premiere project with the same name as the one you are going to import.  This is 

only required for importing an eMAM project.   

b. If you are importing a Premiere project, you can select the project and click on Import. 

c. After importing a project from the panel, select the imported project from the eMAM panel and 

click on the Checkout button. 

d. This will make sure that the project is checked out and the other users cannot import it. 

e. After the editing work is complete, you can click on export to create a new project version in 

eMAM and to check in the project. 

f. Markers created in eMAM will not be recreated during import for the CC version. 

 

Limitations under Adobe Premiere Pro CC: 

a. In Adobe Premiere Pro CC version, markers added to assets in eMAM are not recreated to 

Premiere assets after import. 

b. Projects do not get automatically Checked Out during import.  You need to manually enable 

Check Out. 

c. New items added to a Premiere project from eMAM Director gets imported automatically when 

that project is imported to Premiere. 

 

Error codes with descriptions 

 Error code 15425102: This message will appear the first time when a project is exported after 
installing the eMAM panel and you have not selected any project file saving location. 

 You need to select a storage location from the dropdown list and click on ok and then 
exporting once again. 
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 Export error code 15428005: This error appears during export when you select Media Encoder 

as the eMAM proxy option and there are no values to select in the dropdown for the ingest 

profile. 

 You need to associate an Original+Proxy ingest profile to solve this issue. 

 

 Export Error 15428006: For eMAM managed proxy creation, at least one managed transcoding 

ingest profile needs to be configured: This error appears during export you select eMAM 

managed transcoding as eMAM proxy option and there are no values to select in the dropdown 

for ingest profile. 
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 You needs to pick an Original+Proxy ingest profile to solve this issue.  If this is not an 

option, please check with your system administrator. 

 

 Error code 15428001: This alert appears when the selected folder associated with the ingest 
profile is not accessible from the Premiere project machine. 

 Change the local folder path 

 
                                               Export error window 

 Error code 15428012: This alert appears when the selected ingest profile associated folder is 

not accessible from the Premiere project machine. 

 Ask the system admin to change the network folder path with your ingest profile in the 

Super Admin Console. 
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                                                          Export error window 

 Error code 15428014: This message appears during export when the required metadata fields 

are empty. 

 Fill in all the required custom metadata fields.  Some fields are required so users can 

organize and find content in the eMAM system.  For clarification, ask your Unit Admin or 

the Super Admin.   

 
                                             Export error window 

 Error code 154215103: This message appears you try to import archived assets. This error will 

not occur if you choose to “Link assets to” the mezzanine version:  if a mezzanine version is 

available in current storage, then it will be imported.    

 Restore the archived assets and import again. 
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                                           Import error window 

 Error code 154213102: This message appears when selected assets are either not supported in 

Premiere or the asset path is not accessible from the Premiere machine. 

 As shown in the below screenshot, two of those assets do not have mezzanine formats 

and the original is Archived. You can important the available assets by clicking on OK, or 

you can stop the import by clicking Cancel.   

                                               
                                     File Import failure window 

 Error code 154217805: This message appears during export when the file title contain special 

characters (“/\:|*?<>). 

 

 Remove the special characters from the file title in the Premiere project and export the 
project again. You do not need to change the actual file name in the local disk. 
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                                          Project Export alert window 

 

 Error code154213002: This message appears when you try to import a checked out project 
from that checked out location and if the last imported project path is not accessible. 

 If you want to open that last checked out project, make sure the last checked out path 
location is accessible from the current premiere machine. 

 

           
                          Import error message window 

 

 Error code 154213003: This message appears when the last imported path is accessible from 
the current location. 

 

 You can select OK to continue importing. 
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                                                 Import checked out project error 

 

 Error code 154213601: This message appears when you try to import a set of assets and the 
asset path is not accessible from the Premiere machine. 

 

 Be sure that the asset location is accessible from the Premiere machine  

 

 
                                          Import error window 

 

 Error code 154213202: This message appears during category import when selected assets are 
either not supported or the asset location is not accessible from Premiere machine. 

 

 Be sure that the asset location is accessible from the Premiere machine.  
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                                          Category import failure window 

 

 Error code 154213302: This message appears during bin import when the selected assets are 
either not supported in Premiere or the asset location is not accessible from the Premiere 
machine. 

 

 Be sure that the asset location is accessible from the Premiere machine.  

 

 
                                                      Bin import failure window 
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 Error code 15429803: This message appears when multiple items with same title result in 
duplicate files being added to the ingest folder. 

 

 Change the asset titles or deselect assets with the same name in the select files tab.  
Export again. 

 

 
 

 qe is undefined: While performing any task, below error message appears. 

 

 

 This means, the extendscript file is (downloaded during eMAM panel installation) 
missing. Copy the 'extendscriptprqe.txt' file and paste it in the respective folder 
<C:\Program Files\Adobe\Adobe> Premiere Pro CC 2017 
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 Please Install the latest panel and try to login: When there is a change in version of the eMAM 
panel, below message appears. 

 

 Depending on where you have installed panel (Windows or MAC), follow steps mentioned 
in Extension Manager Command line tool (Windows and MAC) page 7 to install latest 
version of eMAM. 

 
 

Exceptions for Import and Export: 

 Import and Export of Projects with name starting with ‘~’symbol is not supported. 
 Import and Export of projects starting with ‘.’ symbol is not supported in MAC environment 
 While using the eMAM panel in the MAC, you should make sure that there is no mounted 

volume with the name "Users". (Volumes/Users) 
 Cannot export projects containing multiple bins with same name. 
 Cannot export projects with asset title containing following special characters /: *?  " < > | 
 Cannot export projects which have multiple assets with same name (assets can be added 

locally to the Premiere project) 
 Cannot Import Locked projects. 
 Auto check out of projects during import does not happen for Adobe Premiere Pro CC 

version (7.0). 
 When exported using Media encoder option, the proxy frame rate and the original frame 

rate will not match. 
 eMAM panel not supported in windows for Premiere pro 9.1 and 9.2 
 New assets added to a Premiere project from eMAM Director will not get imported to the 

project during the next project import (Premiere pro 7.0 and in Premiere pro 9.0 in MAC). 
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Adobe Premiere Pro version 

To know about your installed Adobe Premiere Pro version details: 

I. Click on Help button from the top menu and then click on About Adobe Premiere Pro. 

 

 
                               Help menu window 

 

II. A new window will pop up giving all details about the Adobe Premiere Pro version installed 

in your machine. In the bottom left hand side of the window, you can see the version & 

build details. 
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                Adobe Premiere Pro version details window 

 

Get Help 

For any more information, please contact eMAM support at support@emamonline.com 

http://www.empressmam.com/
mailto:support@emamonline.com

